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Getting started with TRAVEO™ T2G entry family
starter kit

About this document

Scope and purpose

This document explains how to set up and use TRAVEO™ T2G body entry family starter kit. The document also
explains how to debug with a single core and dual core environment in IAR embedded workbench for Arm®
(EWARM). The document uses the TRAVEO™ T2G body entry starter kit board with the sample driver library
(SDL).

Intended audience

This document is intended for software and hardware engineers integrating TRAVEO™ T2G body entry device
into their application.

Abbreviations and definitions

Table1 Abbreviations
Abbreviations Description
CMo+ Arm® Cortex®-MO0 plus
CM4 Arm® Cortex®-M4
SDL sample driver library
SK starter kit
USB universal serial bus
EWARM embedded workbench for Arm®
C-SPY high level debugger language for embedded system

Reference documents
[1] KitProg3 user guide

[2] TRAVEO™ T2G starter kit user guide
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Getting started

1 Getting started
This section explains the hardware setup. Table 2 lists the prerequisites for the setup.
Table 2 Prerequisites
Quantity Description Remarks
1 CYTVII-B-E-1M-SK TRAVEO™ T2G body entry series starter kit
1 Micro USB cable For power and communication
1 PC With USB port
1 IAR EWARM 8.42.1 Downloaded from the web
1 Sample driver library v7.0.0 Downloaded from the web
- Firmware Pre-installed
1.1 Connection setup

Connect the USB cable from the PC to the starter kit. The starter kit is powered by the PC via the USB cable
(5V). Check if the mode LED (LED3) and the power LED (LED2) are turned ON.

Figure 1 Connection between PC and starter kit

1.2 Power up

When powered ON, the device will start executing the pre-installed firmware, which is indicated by the blinking
user LEDs (LED1 is controlled by core Arm® Cortex®-M0+ (CM0+) and LED4 is controlled by core Cortex®-M4
(CM4)).
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Getting started

Note:

infineon

To indicate that the starter kit is powered ON and the USB controller is starting in the correct
mode, the amber-colored status LED3 must be permanently ON. But, LED3 does not indicate a

successful USB driver installation.

TRAVEO 11 ENTRY FAMILY STARTER KIT
600-60542-01 Rev 03

Figure 2

1.3

LED indicating power ON

Installing kit driver

To work with the starter kit, the KitProg3 USB-UART driver must be installed on the system. This driver is part of
a firmware package and must be installed manually. Optionally further information about KitProg3 see [1].

To install the KitProg3 USB-UART driver, do the following steps:

Sl R

Download firmware-loader package
Extract the package.

Depending on your operating system, browse fw-loader\bin\drivers\KitProg3\KitProg3UART.
Right-click the file “KitProg3UART.inf” and execute “Install”. Then the driver is being installed.

Confirm that the starter kit is recognized as a KitProg3 device on Windows (open Device Manager, follow the
menu path View > Devices by container) as shown in Figure 3. This completes the hardware setup.

M Device Manager

File Action | View |Help

Devices by type
Devices by conmection
Devices by container
Rescuroes by type
Rasouroes by connection

A iPrint Show hidden deviors
= iPrint
= iPrint

Customize..

= iPrint Assistant (Postscript)
R ISCNRS0SXDGN

€

¥ FitProg3 CMSIS-DAP

W KitProg3 USB-UART ([COMS)
§ USE Compasite Device

g USE Input Device

e USE Input Device

¥ HID-compliant vendor-defined device
¥ HID-compliant vendor-defined device

Figure 3
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Note: Do not press SW3. Pressing SW3 changes the mode of the USB controller. This is necessary only for
upgrading the USB driver firmware and other activities. For more details, see the KitProg3 user

guide [1].

For more information related to the starter kit, see the TRAVEO™ T2G starter kit user guide [2].
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SDL and IAR EWARM setup

2 SDL and IAR EWARM setup

This section explains how to run an example from the SDL on the TRAVEO™ T2G starter kit using the IAR C-SPY
debugger.

2.1 SDL environment setup

Download the latest SDL for the TRAVEO™ T2G starter kit on the target system. Install the SDL outside the
default program files to allow the IDE to access and create temporary files. Figure 4 shows the sample path.

Home Share View
¢« v 4 > ThisPC > Documents > Software > Traveo > TVII_Sample_Driver_Library_7.0.0
Name - Date modified Type Size
# Quick access
common
& My Desktop docs
e My Documents misc
tviibeTm
@ My sync tviibe2m
& Nextcloud tviibedm
tviibe512k
@ OneDrive tviibhdm
2 This PC tviibh8m
tviic2d4m
& Network tviic2d6m
tviic2démddr
E License
Fa Readme
B unins000 2
7 unins000 21-01-2021 11:15
Figure 4 SDL 7.0.0 top-level directory
2.2 IAR EWARM setup

Open the Readme.pdf from the root folder of the SDL and use the same link to download the version of IAR
EWARM supported by the SDL.

Download the software and run the installation (note that the installation might take some time). When you
open the IAR EWARM for the first time, select the license in the License wizard. If you do not have the license, it
is strongly recommended to register for a Code size limited license type. See Figure 5.

Note: IAR EWARM v8.42.1 is only for reference; always use the IAR EWARM version supported by the
specific SDL release.

User Guide 6 of 25 002-32910 Rev. *A
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SDL and IAR EWARM setup

SIAR

~

SYSTEMS

Register for Evaluation

Please compiete the following registration in order to compiete the activation of your product
The information proviced in this registration confirms the user and physical location where the
product is being used

Evaluation license type

Time limited (30 days)
IAR Embedded Workbench for Arm, v. 8.42. Evaluation Edition

Code size limited
IAR Embedded Workbench for Arm, v. 8.42. 32K Kickstart Edition

First name
Figure 5 Registering IAR for evaluation (based on v. 8.42)
2.3 Verify installation by quick hands-on

The starter kit is now ready to use after a successful environment setup (USB driver installation, SDL
installation, and IAR installation). To verify the installation and setup is complete, quickly walkthrough the
following steps:

1. Connect the USB cable from the PC to the starter kit, LED2 and LED3 should be ON.
2. After power-up, LED1 and LED4 will start blinking from the pre-installed firmware on the kit.

Start IAR EWARM and open the SDL template workspace file:
tviibelm\tools\iar\flash\tviibeIm_flash_cmOplus_template

Select the workspace revision starter_kit from drop-down list under Workspace.
Click Project from top menu and select Rebuild All.
Check for the successful build from the Build tab at the bottom left corner in IAR window.

The kit is already running a pre-installed firmware on it so we can connect to target CPU (TRAVEO™ T2G) by
selecting Attach to Running target option from the Project menu.

8. Thedebuglog shows the interface and device information in the Debug tab at the bottom left corner.
9. Click pause to check the CPU execution, LED1 will stop blinking due to the pause action.

10. Now click the stop debugging button to detach the target.

11. Close the IAR window and reset the starter kit using switch SW2.

w

N o ook

Note: In case of problems, see Troubleshooting.
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Build  Debug Log _Ambiguous Definition

Ready

R Type here to search

Errors 0, Wamings 0

© wiibe1m_flash_cmOplus_template - IAR Embedded Workbench IDE - Arm 8.42.1 — o X
File Edit VlewCMSIS-DAP Tools  Window Help (T3] Ada Futes...
NO @ = KO D C RO~ < >N R®-s O > il [ Add Group
Workspace v 3 X main_cmOplus.c x o systick [4] import File List. =
4 l user_led_port_pin_cfg Add Project Connection... fo
Edit Configurations.. L)
e <
1 @) lus - starter_kit [v | | cy_st | p tg = X Remove
(
O create New Project...
DM_STRONG_IN_OFF, @ Add Existing Project...
a N_MUX,
|- Wi rev_d & oOptions... Alt=F7
Version Control System »
{~@ ol drivers ® Make =
interrupts
| B | compite 7
startup @ Rebuild Al |5
@ ol system @ | Clean
& B main_cm0plus.c -~ (. -
@ W Output s ch build..
C.STAT Static Analysis »
int main (void)
= ©  stop Build trl+ Break
__enable_irg();
© Download and Debug Ctri-D
»  Debug without Downloading
: %) Attach to Running Target
EX_M4_APPL_ADDR) ; Mal Debu iR
- trie
cmlphus < > v
Download »
Buid v ax
SFR Setup
Messages e Line s
Linking o CMSIS-Pack Manager
cmOplus.out 6 Open Device Description File »
Converting Save List of Registers.
Total number of errors: 0
Total number of warnings: 0

Figure 6 Build a workspace in IAR

@ wiibem_flash_cm0plus_template - IAR Embedded Workbench IDE - Arm B42.1

File Edit View Debug Disassembly CMSIS-DAP Tools Window Help

L Type here to search

Aar ] YRR AR Ol b s ¢ [ AddFies..
Workspace v 0 X | main_cmdphisc x o systick.c [@ AddGroup..
= maing) 10 9 [} import File List
= int main(veid) Add Project Connection...
Files . ( Edit Configurations...
= @ cmDplus - stanter_kit -l
) i hdr Remave
W cmsis SystemInit():
rev_b ) 1O Creste New Project...
rev_c ™ Add Existing Project.
@ rev_d y_ ApplCore (CY_CORTEX M4 APPL A
] cy_projecth & options... Alt-F7
'y GPI0 Pin Init(USER LED PORT, USER LED PIN, suse: pocE,_pin_ctg) : Version Control System
foriin) 0 v 7
{ B compie -F
y SysTick_DelaylInus( )i @ revuid Al
L3 Cy_GPIO_Inv(USER_LED_PORT, USER_LED_PIN)|: & Clean
L ) ‘ & Batch build... 8
CSTAT Static Analysis
] Brea
© Downlcad and Debug Cirl-D
emliphes « »  Debug without Downloading
Debug Lo 7] 2 Attach to Running Target
Make & Restart Debugge: trie
Log estart Debugger = Shift
Tue Sep 21. 2021 19:25:27: Connected DAP w2 on SWD. Detected IDCODE =(xbba02477. 8 e
Tue Sep 21, 2021 19:25:28: Connecling to TAP#0 DAP AHE-AP port 1 (IDR=0x84770001) —
Tue Sep 21, 2021 19:25:26: Recognized CPUID=0x410ccB01 Contex-MO+ 0p1 arch ARMvE-M SFR Setup
Tue Sep 21, 2021 19:25:28: Debug resources: 4 instruction comparators, 2 data waltchpoints.
Tue Sep 21. 2021 19:25:28: Loaded debugee: CiUsers\SarstAkshat\Documents\Software\ Travec\SDLITVIFSW-FWTVIFS smp belmitoo A By CMsIS-Pack Manager
Tue Sep 21, 2021 19:25:29: 6155 bytes verified (41.17 Kbyles/sec) e ]
Tue Sep 21. 2021 19:25:29: Attach to running terget completed
Tue Sep 21, 2021 19:25:29: INFO: Configuring trace using 'MTE PegBase=0x0003000 MinRamAddr=0x0010000 MaxRamSize=0x1000' seting .. Save List of Registers.
Tue Sep 21, 2021 19:25:29: MTB, Available 4KB at 0xFD010000
Tue Sep 21, 2021 19:25:29: Reserved MTB Trace buffer memory: 0xF0010000 - 0xF0010FFF (01000 bytes).
e S R T PRI
Build Debuglog Ambiguous Definition
Ready

- o X
Disassernbly vax
Galo Memory
Disassembly e

0x1000°155a

0x1000
0x1000°1560
0x1000°1562
0x1000°1564
0x1000°1566

0x1000°156a
0x1000°156c

0x1000°1572
0x1000°1574
0x1000°1578
0x1000°157a
0x1000°157c
0x1000°1580
0x1000°1584
0x1000°1588

155=

0xf7ff OxfcO

Ox4c0B

0x4a08
0x2100
0x0020
0xf7ff Dxfdf.
0x4807

0xf7ff Oxfe?

ER

0x0020

0xf7ff Oxffe
Oxe7E7

0x0000

0x1008' 0000
0x4031'0980
0x0800 "' 0dB4
0x0000'c350

__lar_zero ,

Figure 7 Check debugger and kit connection in IAR
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Download and debug with starter kit

3 Download and debug with starter kit
There are two debugging methods with IAR EWARM:

e Debugging with code downloaded on to RAM
e Debugging with code downloaded on to the flash memory (described in this document)

SDL supports three types of workspaces under flash memory debugging as listed in Table 3.

Table 3 IAR Flash workspaces and functions
Workspace Application | Number of Details
core cores supported
Single core CM0O+ workspace No Single Single core download and
“tviibelm_flash_cmOplus_template” debug for CM0+ core.
Single core CM4 workspace Yes Single Single core download and
“tviibelm_flash_cm4_mc_template” debug for CM4 core; works as
client/slave workspace in
multicore configuration.
Note: It is possible to
debug only with
CM4, when CM0+
executes some
code, thus
enabling CM4.
Dual core CM0+ and CM4 workspace Yes Dual Dual core download and debug
“tviibelm_flash_cmOplus_cm4_template” for CM0+ and CM4 cores; works
as master workspace in
multicore configuration.
Note: Both CM0+ and CM4 can do normal code execution, but from an architectural point only CM4 is

considered as the application core. After a reset, the default core is always the CMO+ core. To
enable the CM4 core, CMO+ must call Cy SysEnableApplCore (). Inthe SDL, this is usually done
within main_cmOplus.c.

Before downloading and debugging with the multicore master project, you must build the multicore slave
project for the application core (which is CM4 here).

Open the master workspace (dual core CM0+ and CM4 workspaces) for multicore debugging. The slave
workspace (single core CM4 workspace) will automatically open from the master workspace when you click
Download and Debug.

User Guide 90f25 002-32910 Rev. *A
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3.1 Debugging with single core CM0+ workspace

1.

Start IAR EWARM and open the SDL template workspace file:
tviibelm\tools\iar\flash\tviibelm_flash_cmOplus_template

infineon

Fde Edt View Projet Tools Window Melp
DORS = XKD DC QRS B0 A R 8.-3.0 ' 0id
Workspace v 3 X
4 @ Open Work
Files o
« v 4 « twabelm » tools » iar » flash - V] Search flash
Organize v New folder v
OneDrive ~ Name a Date modified
@ OneDrive & cmiplus 09-02-2021 12:28
. % cmOplus_omd
B8 This PC &) cmé.me
B 30 Otjects settings
I Oesktop ) tvibelm_flash_emlplus_emd_template 016:28
% Documents €D tvibelm _flash_condph Pl 22-10-2020 1628
& Downloads phmlm_ﬂuh_w_m_tmp‘le 28-10-2020 16:28
D Music
= Pictures
B Videos
‘s Windows (C))
v <
il ' File name: {Mibdm_ﬁnh.(nﬁlm_lempht: v Vhﬂhpxcﬂs(‘.wvﬂ
Messages Open Cancel
< >
Ready Errors O, Waerangs 0 in 1128 Col 26 System | CaP NUM OVR T
Figure 8 Selecting CMO+ single core template

2. Select the workspace revision starter_kit from the drop-down list under Workspace, as shown in

Figure 9.
Note: Ignore other workspace revisions for this starter kit. The other revisions constitute the MCU
assembled on other evaluation boards (CPU board).
User Guide 10 of 25
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@ tvibelm _flash_cmOplus_template - LAR Embedded Workbench IDE - Arm 8.42.1 - (a] S
Fie Eat View Project CMSIS-DAP Tools Window HMelp
DO = XK0O DC -l D> S eE 8 > (10 RS .0 - CihT
Workspace * B X main_cmOplusc X -
[tate b v fo
rev_b . ~
av_c .
1:
Wcmsis int main(void)
rev_b 3
rev_c SystemiInit();
Wrev_d
m(_y_pvot'eah —_enable_ixq():
o sic -
o dnvers b 5 oo d
o interrupts
-m~ ace ey 10t An/ata vt o
S stestup Cy_GPIO_Pin_Init (USER_LED_PORT, USER_|
o system
‘—E_ E) main_cmOplus.c for{::)
& & Output {
):
P10_Inv(USER_LED_FORT, USER_LED PIN);
)
)
cmlphus < > v
Build v 3 x
Messages
< >
Buitd Debuglog Ambiguous Defintion
Ready Errors 0, Warnings 0 tn 46 Col 1 Syitem  CAP NUM OVR BB
. . . .
Figure 9 Selecting workspace revision
. . . . .
3. Forthe build, right-click cmOplus - starter_kit and select Rebuild All.
© tiibelm_flash_cmOplus_template - LAR Embedded Workbench IDE - Arm 8.42.1 - o x
Fde Edt View Project CMSIS-DAP Tools Window Melp
DORG & XKL DC 2L Q28r2< 0> AO8 0 » . &
Workspace ¥ 0 X main_cmOplus.c X v
starter_k2 v fo
Fies o e o .vohSel = 0, ~
2 cmog
5 ol hdr Options... Ant main(void)
I-& o cmsis {
@ i rev_b Make SystemInit():
8 = rev_c Compide
& o rev_d Rebuild Al enable_irq();
'— Boy_p
5 ol src e /* Eaable Q. it e Tnvease
|- ol driver C-STAT Static Analysis 5 Cy_SysEnableAp
-2 o imermu
@ o mw Stop Build
-3 o star ~F =
@ & syster for(::)
—8 B main_ Remove {
@ & Output 3 -
k_DelaylInUs(50000);
Version Control System » nv (USER_LED_PORT, USER_LED_PIN):
}
Open Containing Folder... ]
File Properties...
cmbplus < > v
Butd - ax
Messages
< >
Bulld Debuglog Ambiguous Defindions
Clean and make the selected project Errors 0, Wamings 0 Ln 46, Col 1 System CAP NUM Ovi
. or s . .
Figure 10 Rebuilding workspace revision
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4. The rebuild process starts. Check for errors and warnings in the Build log.

@ tviibem_flash_cmOplus_template - IAR Embedded Workbench IDE - Arm 2.42.1 - o x
File Edt View Projet CMSIS-DAP Tools Window Help
DOME m ARG OC R NCTON WS I WD N RN NORE W
Wodkspace ¥ 8 X main cmoplusc X v
staster bt v fo
«wohSel = 0,
Files e . W * A
[=R JcmOplus - starter_kit v
8 hor int =ain(void)
& cmsis 3 1
rev_b SystemInit():
rev_c
S rov_d enable_irq():
L— Doy projecth
ol sic ¢ Enable CMé. CY.C ¢6_APPL ADCR is calculated ia linker script, check 1t in cese o

o drivers Cy_SysEnableipplCore ( EX_M4_APPL_ADCR) ;

o inerrupts - _ B

ol e * Place you al startup code e.g. MyZInst Start(

-ﬂum)p Cy_GPIO_Pin_: USER_LED_FORT, USER_LED P suser_led port pin cfg):

= system fortss)

B main_cmOplus ¢ {
@ ol Output

laylaUs(s b
v(USER_LED_PORT, USER_LED_PIN):

cmligha < > v
Bullg

v aXx

Messages (4]

Total number of erors: 0
Total number of wamings: 0

< >

Build Debuglog Ambiguous Detinion

(s \J ATVILSW-PWATVIL-Sample SWibviibe 1t oolsars Errors 0, Warmings 0 in &5, Col 1 System  CAP NUM Ove SR

Figure 11 Checking build status in build log

5. To load the program to the flash region of CM0+ core, click the green Download and Debug icon.

o tvibeim_flash_cmOplus_template - IAR Embedded Workbench IDE - Arm 8.42.1 - o xX
File Edt View FProject CMSISDAP Tools Window Melp
DOME = AKS 2C Q2 B2 U 0NN RO m[0] cid
Workspace ¥ 8 X main cmdplusc X .
 Download and Debug (Ctri+D)
staster bt v fo
.vohSel = 0, Download the application and start N
Files A P the debugger
=X JcmiOplus - starter_ kit v a9
ihgv int main(void)
& cmsis =N
rev b Systenlnit();
rev_c
wrev_d __enable_irq();
B cy_projecth
- ¢« Enable ON§. ) eck it in o
o src Eoadble CNé. C¥ k it in ca
o deivers Cy_SysEnableAppl
o interrupts
-"M
@ o stamap
o system fortss)
& main_cmplus ¢ ¢
L5 & Output . Fait 0.0¢
Cy_SyaTick_De. nUs (50000)
Cy_GPIO_Inv(USER_LED_FORT, USER_LED_PIN):
)

cmliphn < > v
Builld

Messages A

Tatal number of errors: 0
Total number of warnings: 0

< > ’
Build Debug log Ambiguous Definttions
Csers\Saratakshat\ Documents\Software\Trave o\ SOUTVILSW-FWATVIR. Sample SWAtviibe Tm\t ools Uar'd Ereors 0, Warnings 0 Ln 44, Col 1 System AP NUM ove SR
Figure 12 Downloading and debugging
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6. Now, click the Go icon to start execution.

Note:
Ctrl+D (Download and Debug).

infineon

You can also use the function keys in the Debug window: Go (F5), F10 (Step Over), F11 (Step into),

@ wiibeim_flash_cmiplus_template - LAR Embedded Workbench IDE - Arm 8.42.1 - o X
File Edt View Project Debug Disassembly CMSIS-DAP Tools Window Melp
DOM@ & AKD DC LGyt ez < Do 1 B8 = 0cOlioIridlePpa-Tima
Workspace ¥ 8 X man_cmOplusc X » Go(F5)
- = Run the program in the debugger
Files o .
2 @cmlplus - starter kit~ v 0x1000°1540: 0x0800°££00
e sindr Cy_u32Star
@ o cmsis 0x1000°1544: 0x0800° £££¢
@ sirev b . nOUT_INV u32Reg:
rev_c Cy_GPIO_In
Wirev_d 0x1000°1548: 0x2201
— D oy_projecth 0x1000°154a: 0x408a
& s src 0x1000°154c: 0x60c2
@ o drvers
ol interrupts N 0x1000°154e: 0x4770
ol int sai id
@ o startup
|-@ o system nain
La @ mein_cmoplus ¢ | 0x1000°1550: 0xbS10° |
L@ & Output Systenlnit
er script 0x1000°1552: Dxf7¢f Oxtb3
0x1000°1556: Dxb662
1 0x1000°1558: 0x4808
; v
I—‘M < i < NvINNN*16Cx- Nwf7¢F Nuf )n
'Debug log v o x
Log 0.
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Figure 13 Debugging with CM0+ core

LED1 should start blinking.
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Figure 14 Blinking LED1
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3.2

1. Start IAR EWARM and open the SDL template workspace file:
tviibelm\tools\iar\flash\tviibelm_flash_cm4_mc_template

Debugging with single core CM4 workspace

File Edt View Project Tools Window Help

DO ES = A0

QENCHN RS ISWONORN W R

2o C |

». "
* i

0 Open Workspace
+ “ tvibelm » tools » ke > flash v O Seaech flash
Organize v New folder - [ 0
OneDrive (4 Name C
@ OneDrive & cmiplus
< us_cma
This PC iy
& cmd mc
B 30 Objects settings
B Desitop OM-belm,ﬂoth,cmDpM_cmd_wuu
% Documents ) tviibem flash_cmOplus_template 28.10- 28
& Downlosds pwﬁbelmMmﬂ_ﬂx_wm | 25-10-2020 16:28
D Music
=~ Pictures
B Videos
i3 Windows (C)
- v < >
R 1 File name: | vibelm flash_cmé_m template ©| WodspaceFies o) v
Messages Concd- | Line
_Ready Errors O, Wamings 0 Ln 45, Col 1. Sptem CAP NUM OVR B |
Figure 15 Selecting CM4 single core template

2. Select the workspace revision starter_kit from the drop-down list under Workspace, as shown in Figure

16.
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° tviilbelm_flash_cmd_me_template - IAR Embedded Workbench IDE - Arm 8421
Fde Eat View FProject CMSIS-DAP Tools Window Help

DO ME &= XKD
Workspace ¥ 0 X  maincmdc x
sharter_kit v

Files L

2 @ cm4 - starter_kit }:
I-& il hat

I-@ ol cmsis int main(void)
@ = rev b =
@ rev_c { ]
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— B cy_projecth

3 ol src

& W deivers

@ ol inerrupts

-2 o mw

[-& 1 rtos

@ o starup

@ i system

@ E) man_cmdc

@ & Output }

o C L (D> % S <

<

Systeainit();

__enable_1zq{);

&

~E <

Bulld

v ax

Messages

<

Buld Debug log

Ready Errors 0, Waenings 0 in40, Col t

Figure 16 Selecting workspace revision

3. Forthe build, right-click cm4 - starter_kit and select Rebuild All.

© tvibeim flash_emd_mc_template - AR Embedded Workbench IDE - Arm 8.42.1

féde Edt View Project CMSIS.DAP Tools Window Help

DO ME = A KD

9 .C
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vax
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v
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{
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Clean
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10 P cod e
it(USER_LED FORT, USER_LED PIN, su

> Cy G
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{
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Figure 17
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4. The rebuild process starts. Check for errors and warnings in the Build log.

File Edt View Project CMSIS-DAP Tools Window HMelp

O = A K0

’

3 C

° tvilbelm_flash_cmd_mc_template - IAR Embedded Workbench IDE - Arm 8.42.1

B®=0 - .

Woekspace
starter_bt v

Files

=X lcm4d
[~ o hdr
HD & cmsis

8 =rev b

=8 Wrev_c

& o rev_d

8 i ros

L— Doy _projecth
-2 o sic

(-8 ol drivers

8 & irtorrupts
@ o mw

I-@ ¥ rios

& o startup

HE & system

L@ B) main_cmd.c
@ ol Output

starter kit

omd <

Build

Ant main(void)

=M |

SystemiInit();

_enable_irq();

your initializatior

a4t (USER_LED |

P <0 M
USER_LED_PIN, cuser_led p

v 3 X

Messages
cmi.out
Converting

Total number of erroes: 0
Tatal number of wamings: 0

<
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Debug Log

CUsers\Sarafakshat\ Documents\Software\Trave o' SOUTVIL SW-FWATVIE Sample SW\tviibe T m\t o olsUar'd

Ercors 0, Warnings 0 Ln 40, Col 1 System

caP NUM Ove SR

Figure 18

Checking build status in build log

5. To load the program to the flash region of CM0O+ core, click the green Download and Debug icon.

File Edit View Project CMSIS.DAP Tools

DOME = XKD

Window  MHelp

o C

@ tvibelm _flash_cmd_mc_template - IAR Embedded Workbench IDE - Arm 2.42.1

B0 =0} . &

‘Workspace
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Files & .
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cy_projecth

DLk
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o mw
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@ o system
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@ ol Output

(33

YTTTIETTY]

[cmt <
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int main(void)

Systemlnit();
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the debugger
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Messages
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Figure 19
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6. Now, click the Go icon to start execution.

@ tviibelm flash_cmd_me_template - AR Embedded Workbench IDE - Arm 8.42.1 - o X
File Edt View Project Debug Disassembly CMSISDAP Tools Window Melp
DOME = L0 D Q252 820N RG8 G cO: 030N P 3. om k4
Workspace ¥ 3 X mainombc X » Go B3 Jpassempy vax
starter_ kit v. -:‘;-|‘_‘. rin i the d—.:_;;r: | Go_vo-_ —
Files e . Disessembly &
© @cmd - storter_kit v f ] 0x10081lcc: €
-2 & har «intEdge = 0,
[-@ o cmsis .intMask = O, 0x1008°11d0: ¢
&8 = rev b VErip = 0, base aOUT
8 Wrev_c .slewfate = 0,
|-@ o rev_d . : ' 0x1008"11d4:
8 ¥ ros 0x1008°11d6: €
— R cy_projecth . 0x1008°11da- €
(-2 o src v
I-@ ol drivers ity 0x1008"11dc: €
@ & interrupts g TSRORINSID; nt msin(void
-8 o mw 4
j-R.A ros %  int main(void)
& ol startup {  Ox1008°11de (
8 Seysten o MELHAY
L@ § main_cmd e © i giiTiE
& M Output __enable_irq{); able_1ix
0x1008"1led - €
: 0x1008° 126 C
. v
ok < 5 " NviNNR* 1 1aR )A’
Debug Llog v ax
Log A
Fn Mar 26, 2021 14:17.46: DMAC: Contex-M0+ core was reset
Fri Mor 26. 2021 14:17:46: DMAC/ Trace: Configunng platiorm side SWO component
Fri Mar 26, 2021 14:17:46: INFO. Configunng race using "swoint{baseswo=0E008_E02. basesm-0xED00_D002)' setting
Fri Mar 26, 2021 1417.46: INFO: SWO race mode i not supponed by the probe (use eykerTrace probe) - ¥ace is disabled
v
< >
Buid  Deduglog Amb tions
Ready Ln 40, Col 1 System  CAP NUM Ovi B

Figure 20 Debugging with CM4 core

LED4 should start blinking.
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Figure 21 Blinking LED4
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3.3 Debugging with dual core CM0+ and CM4 workspaces

1. Start IAR EWARM and open the SDL template workspace file:
tviibelm\tools\iar\flash\tviibelm_flash_cmOplus_cm4 _template

@ 17 Embedded Werkbe
Fide Edit View Project Tools Window Melp
1 N = = ~ bal n
DO MG 8 ARG OC Sl B2 0200 B0 s 0 b
— ;_.l OOPmWodupue X
Fies o
+ « tvilbelm » tooks » iar » flash v O ) Search flash
Organize v New folder SN | o
OneDrive A MName
@ OneDrive & cmlplus
& cmplus_cmd
B This PC 2 cmime 09- 2
B 30 Opjects settings 10-11-2020 1505
B Desiacp fibelm_flash_cmOplus_cmd_templ 28-10-2000 14622
4 Documents tviibeTm_flash_cmiplus_template 16:28
& Downioeds ) taibelm flash_cmd_me_template
D Music
= Pictures
B Video:
‘s Windows (C)
" v < >
id | File name | tvibelm flash, cmOplus_cme tempiate v| [WorkspaceFiles eww)
Messoges Cancel Line
Ready Errors 0, Warnings 0 Lnd2 Col $ System  CAP NUM Oovi B

Figure 22 Selecting CM0+ and CM4 dual core template
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2. Select the workspace revision starter_kit from the drop-down list under Workspace, as shown in

Figure 9.

© tvbelm flash_cmOplus_cma template - Master - AR Embedded Workbench IDE - Arm 8.42.1 - a X
File Ear View Projed CMSIS-DAP Tools Wwndow Help
oA 8 L0 Dc, s Qo Sex< DD Re= O L&)
Workspace ¥ B X maincmOplusc X bo_bip tibelm_starter bah -
startes_kk v fo
Fies G e SohSel = O, ~
= @ cmOplus - starter_kit v
g s hdr int main(void)
@ o cmsss {
=G Nrev b SysteaInic();
@ ¥ rev_c
& o rev_d _enable_irq():
L— D oy_projecth
b-g o src in linker zcrip eck it in case of p
@ o drivers
2 i internapts - ) r . g
& mw * Place your initialization/startop cod £e (e.g. MyInst Stazt()
& buron [ ] | Cy_GPIC_Pim_Init (USER_LED_PORT, USER_LED_PIN, suser_led port pin_cig):
-.."”h for{:;)
l_semhosnng (
8 sw_Smer ¥
-8  startup yaTic s H
G . system Cy_GPIO_Iav(USER_LED_FORT, USER_LED_PIN):
@ &) main_cmOplus.c }
@ & Ougput )
[ cmidpiue. < >y
Busd v o x
Messages
< >
Bulld  Debug log
Ready Errors 0, Wanings O n 56, Col 1 System  CAP NUM OvR S
. . .o o
Figure 23 Selecting workspace revision
. . . . .
3. Forthe build, right-click cmOplus - starter_kit and select Rebuild All.
° tviibeim flash_cmOplus_cmd_template - Master - LAR Embedded Workbench IDE - Arm £42.1 - =] X
File Eat View Project CMSIS-DAP Tools Window Help
DO @ XRODC e Qs8N0 Re.n 0 i
Workspace w8 X main_omOpiusc X b5 _bip_tiibetm_starter th -
sarter b2 v fo
wohSel = O,
Files 1s “ o
2] lcmOplus - starter kit | v |
|2 o hdr nt ®ain(void)
P tens.... -
& W cmsis Or
2 " rev. b Make SystemInit();
HB srev_c :
-8 s rev_d ompee _enable_irq():
— R oy _projecth Rebuid All
o s RS in linker script k it in caze of p
& . drivers
@ W interupts C-STAT Static Analysis > oo
—Gimw Place your initializationa/startcp de Rere (o, N £
& button Yop Build Cy_GPIO_Pin_Intc(USER_LED PORT, USER_LED PIN, suser_led port pin_cf9);
& flash
= for(::)
|-@ i semihosting Add ’ ¢
- o sw_tmer 2 Bait 0.08 1s
-El-_s!anup R Cy_SysTick_DelaylnUs(50000);
- & system Seachicn Cy_GPIO_Inwv(USER_LED PORT, USER_LED PIN);
L& B main_cm0plus ¢ )
= - introl >
L & Output Version Control System
Open Containing Folder...
emidphus File Properties... > v
Ssd Set a5 Active WIRER
Messoges
< >
Bulld Debug log
Csers\SarstAkthat\Documents\Software\Trave o\SDUTVIL-SW-FYWATVIL Sample SWitviibe T m\tools Jary Errces O, Warmings 0 Ln 56, Col 1 ystess A NUM Ove T

Figure 24 Rebuilding workspace revision
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4. The rebuild process starts. Check for errors and warnings in the Build log.

© tibelm_flash_cmdplus_cmd_template - Mastes - AR Embedded Workbench IDE - Arm 8.42.1 - o x
File Eot \View Project CMSIS-DAP Tools Window Help

DOME = LKO 2C -l QLD 5 a8 < 2.[3.0)
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-
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(
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@ v d
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5 (50000) 5
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v o x

Messages
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Total number of errors. 0
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\Software T SOUTVESW.PWATVILS dvide Im'tools sy Errors O, Warnings O Ln 56 Col t Syrtem

Figure 25 Checking build status in build log

5. To load the program to the flash region of CM0+ and CM4 cores, click the green Download and Debug icon.
This will automatically open the CM4 multicore client workspace, and the corresponding code will be
downloaded into the flash region of respective cores.

© tibelm flash_cmOplus_cma_template - Master - IAR Embedded Workbench IDE - Arm 3.42.1 - o X
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Figure 26 Downloading and debugging
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6. Place a break pointinthe systemInit () APlin the CM4 core workspace. CM4 core will start executing after
being enabled by CM0+ core. You can debug both cores simultaneously.

Note: To place a breakpoint at the target instruction, click the white space between the editor window
(left pane) and the workspace window (center pane).

Foe Eon [View | Projet Debuog  Duaisemdly (MSSDAP Took Window  Help

DO0RE B LK D.C =4 Q2 %5r2< 00> RO 8 GCcO, Mo-01- ¢ 5. & o
Wortipace v 3 X man owOphise X L oo slartes 2

st k2

Files o -
0 @ cmbples - staner. v

Ox1000°1552 Oxf7¢4

0x1000"1556  OxbE62

0x1000°2558  0x4208
0%1000°155a° Oxf7¢¢

| ontichn > v e >
© tvibeim flash_cmd_me_template - Partner 1 - LAR Embedded Workbench Of - Am 8.82.1 o X
Fle ESt View Project Debeg Disisemdly C(MSSOAP Tooh Window Help
DORS B 4N Sk Q2 s < 000 B0 = 6O, 20 Do i T 00 @) . e Ci.
Wortipace v 3 X manomic % ' . Mter At v  Duattembly - ax
sate kit v fo Gow
- Drassambly A
v ) 0xd €
Oxd €
0x6 €
ox2 C
Oxa €
Oxe €
Oxe €
R_LED_FIN » > n_cty ox10: €
ox12: €
Ox14- €
Ox16. €
0x18. C
T3_LED_PIN Sanyt
— Oxle: (V¥
o < vile >
Desug log voax
: Debwglog
Figure 27 Dual core Debug windows

7. Now, click the Go icon in the CMO+ workspace to start execution. After executing
Cy_ SysEnableApplCore (), CM4 core will be enabled and the execution will reach the breakpoint in the

CM4 workspace. You can now continue to debug the code from CM4 core.
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File Edit View Project Debug Disassembly CMSIS-DAP Tools Window Help
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Figure 28

Debugging with CM0+ and CM4 cores

LED1 and LED4 should start blinking once both the cores are running.
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4

Troubleshooting

This section explains possible issues and the workarounds.

4.1 Connection troubleshooting

Error: Starter kit is not detected on the target system.

Connect the USB cable that comes with the starter kit. Other USB cables may not connect data lines
Make sure LED3 is ON (CMSIS-DAP mode). If not, press SW3 to change the KitProg3 device mode

If LED3 is ON (CMSIS-DAP mode), change the KitProg3 device mode by pressing SW3. Now LED3 is smoothly
blinking. Then try to reconnect the debug session. Then independently if this works or not, stop the debug
session again and switch the KitProg3 device mode to LED3 is always ON (CMSIS-DAP mode)

Make sure jumper R11 is closed

4.2 Driver troubleshooting

Error: Driver is not detected on the target system or “KitProg3” is not visible

For more information on the supported driver, see the KitProg3 user guide [1].

4.3 Debugger troubleshooting

Error: While programming TRAVEO™ T2G device, CMSIS-DAP device is not found.

Check the USB cable connection and the state of LED3 (LED should be ON for CMSIS-DAP mode).

4.4 Key points

CMO+ core should be running while debugging with CM4 in single core mode. CM0+ core enables the CM4
core by callingthe Cy SysEnableApplCore () API

CM4 core workspace (tviibelm_flash_cm4_mc_template) should be built before building the dual core
workspace (tviibelm_flash_cmOplus_cm4_template)
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Revision history

Document | Date of release | Description of changes

version

** 2021-04-08 Initial release

*A 2021-09-29 Added instruction to install KitPro3 USB-UART driver manually in section 1.3
Moved “Download and Debug with Starter Kit” to section 3.
Added “Verify installation by quick hands-on” at section 2.3.
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delivery terms and conditions and prices please
contact your nearest Infineon Technologies office
(www.infineon.com).

WARNINGS

Due to technical requirements products may contain
dangerous substances. For information on the types
in question please contact your nearest Infineon
Technologies office.

Except as otherwise explicitly approved by Infineon
Technologies in a written document signed by
authorized representatives of Infineon
Technologies, Infineon Technologies’ products may
not be used in any applications where a failure of the
product or any consequences of the use thereof can
reasonably be expected to result in personal injury.


http://www.cypress.com/support
http://www.infineon.com/
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